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Goals

Introduce Internet Explorer
Use the Address Bar

Close a Window

Internet Explorer Interface
Click a Hyperlink

Save a Picture

Use a Search Engine

Add a Favorite

Print a Page and Print Preview
Use the Home Button

Copy and Paste a URL
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Introduction to Internet Explorer

Click the start button, choose All Programs, and select
Internet Explorer.

You can look in your desktop and double click on the
Internet Explorer icon. Setting Internet Explorer on
Desktop. You will see Internet Explorer open to a
Home page.

The Home page is the page you see when you first
open Internet Explorer. Your Home page may be
different. (Set Home Page to Google.com)



Use the Address Bar

You can use the Address bar to go to a page on the Internet.
Click the Address field.

You will see the current address highlighted.

Address | M glase R e s RE il

Type a new address for a Web site over the current one.
Address Rittp: flveww. seawarld. com

Click the Go button on the Address bar.
(30

You can also press the Enter key on the keyboard.

You will see the Web page open.

You will see the Web page open.




Close a Window

You can close windows that show up on top of a Web
page.

You may see a new window when you arrive at a Web
page or click a link.

Click the Close button in the corner of the window you
want to close.

Copernica




Internet Explorer Interface

* The Internet Explorer Web browser is made up of different parts.
* You view Web pages in the browser window.

* You use the menu bar to access program options. The menu bar is at the top of
the WlndOW File Edit W“iew Favorites Tools  Help

* The Navigation toolbar contains buttons for common actions.
Q- @ A G P Yo @uae @ -5 B-1J B
* C(Click a button to perform an action.
* The Address bar tells you the address of the Web page you are looking at.

type where you want to visit.
e fddress |@ kg fhansne, seavworld, conmy V| 50

Welcome to SeaWorld!




Use the Home Button

[f you have looked at other Web pages, you can return to
the Home page. The Home page is the page you see when
you first open Internet Explorer.

Click the Home button.
You will see the Home page.
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Click a Hyperlink

You can use hyperlinks to take you to another part of a Web
page or to other Web pages. A Hyperlink can be text or
graphics.

A hyperlink is usually colored blue and underlined.

www.picsdlearning com

Move your cursor over a hyperlink. The cursor will change
tO the Shape Of a hand. http:,l',l'www.pic54learning.cnm,l'|

www picedlearning com
I

Click a hyperlink to go to that page. >~ 2=
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Use the Back Button

* You can go back and look at Web pages you have just visited.

¢ If you have visited pages since opening the Web browser, the
Back button will be green.

* This lets you know that you can click it.
* To go back one Web page, click the Back button.

; ¥ ahootigans!

Fle E& Veow Feordes Tooh Help

* You will see the Web page you were at before.
* Click the Back button again to go back even further.




—

Save a Picture

You can save pictures from Web pages you visit.

Go to a Web page with a picture you want to save.

Right-click a picture you want to save.
You will see a menu.
Click Save Picture As.

You will see the Save Picture dialog.
Choose a place to save the picture.

If you want to change the name, type a new name in the File name field.
Click the Save button.
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Use a Search Engine

Type in the address bar and press enter.
You will see the Google main page.
You will see a blinking cursor in the search field.
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Type Smithsonian Institution
Click the Search button.



http://www.google.com/�

Add a Favorite
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* You can add a Web site to your Favorites list. Favorites are saved as a list of links.

Go to a Web site you want to keep as a Favorite.

Click the Favorites button on the Navigation toolbar. <> ravarites

You will see the Favorites toolbar.

Click the Add button on the left side of the toolbar.
You will see the Add Favorite dialog.

Click the OK button.

The Web site will be added to your Favorites.
Click the Favorites button to close the Favorites toolbar.
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Print a Page and Print Preview

You can print a Web page you visit. This is useful if you want to look at information when
you are not at a computer.

Go to a Web page you want to print.

Click the Print button on the Navigation toolbar.
This will print the Web page.

You can use the Print Preview feature to see how a Web page will print.
Open a Web page you want to print.

Go to the File menu and choose Print Preview.

You will see the Print Preview window.

A Web page may print on more than one sheet of paper.

Click the arrow keys next to the Page field to see the rest of the pages.
Click the Print button to print the Web page.

You will see the Print dialog.

Click the Print button.

Click the Close button in the Print Preview dialog when you are finished.

e



Copy and Paste a URL

You can copy and paste the Web address, or URL, of places on the Internet into other documents.
Go to a Web page that you want to copy the URL for.
Click the cursor inside the Address field.
You will see the URL selected.

Go to the Edit menu and choose Copy.
Open the document that you want to add the URL into.

Click to place the cursor on the page.
Go to the Edit menu and choose Paste.
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You will see the URL added to your document.
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_—Great websites to help u
tools for teachers:

s with

* TEA-

* TEKS- (great for lesson plans)
* Education helper- (has everything)
Math

* Elementary-

e Middle School-
» Algebra-

* Geomerty-
* TAKS-
Science

* Elementary-


http://ritter.tea.state.tx.us/index.html�
http://ritter.tea.state.tx.us/teks/�
http://www.edhelper.com/�
http://edweb.tusd.k12.az.us/ekowalcz/math/elementary_web_sites.htm�
http://edweb.tusd.k12.az.us/ekowalcz/math/elementary_web_sites.htm�
http://www.edhelper.com/middle_school_math.htm�
http://math.about.com/od/algebraworksheets/a/Algebraws1.htm�
http://www.mathsisfun.com/geometry/index.html�
http://www.aplusmath.com/Worksheets/index.html�
http://www.ncsu.edu/imse/4/elementaryEd.htm�

-

~Great websites to help us with

tools for teachers:

Middle School-
Biology-

Chemistry-
Physics-

TAKS-

Texas Association for Health, Physical Education, Recreation &
Dance

Region One
Texas State Board for Educator Certification


http://www.middleschoolscience.com/�
http://highschoolace.com/ace/biology.cfm�
http://highschoolace.com/ace/chemistry.cfm�
http://www.glenbrook.k12.il.us/gbssci/phys/Class/BBoard.html�
http://www.roomd113.com/TAKS TEST.htm�
http://www.tahperd.org/�
http://www.esc1.net/�
http://www.sbec.state.tx.us/SBECOnline�




Rattler Mail

District E-Mail Directory

e www.rgccisd.org

e Go to District Information
e Click on District E-mail Directory



http://www.rgccisd.org/�
http://www.rgccisd.org/�
http://www.rgccisd.org/2008-2009 District EMAIL.pdf�

Rattler Mail

In Rattler Mail we will learn how to:

Compose a message
Addresses
Folders
Options
e Personal Information
e Message Highlighting
e Change Password
e Address Groups
e Display Preferences
e Folder Preferences
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mail.rgccisd.org

Usually your username is your first initial, last name,
school number @rgccisd.org (Example: Araceli Ibanez
who works at Grulla Elementary would be

)

Password -If you have not changed it is your last name.


mailto:aibanez102@rgccisd.org�

Compose

Add Signature
Add Attachment

Add Addresses.
Save, Send,

Check Spelling
Send To Groups

3l RattlerMail 1.4.2 - Microsoft Internet Explorer
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Addresse

* Add to Personal
Address book.
e Import CSV File.

RatilerMail 1

File Edi view Favorites

Microsoft Internet Explorer,

Help
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address | ] httpijmalrgecisd. orgisrcfwebmai php

v Be ke

Google | v | M search - gD - Al - o Bookmarks~ P check - ] AutoRil - 4 Sy - (siantn -
] igarzal12@rgecisd org Trna Garza marral 12(@rgccisd org 1st Grade i
B5% of S0 O jandersonl12@rgccisd org Jeannie Anderson janderson 1 12@rgeeisd org 4th Grade

O jgarzal 12@rgecisd.org Joseph Garza garzal 12@reccisd org PE Aide

Folders O Jjramirez] 12@rgeeisd. org Tudy Ramirez ramirez] 12@rgecisd. org Dyslexia

b?:;r"leg‘:;?“ O ldiazl12@rgccisd. org Laura Diaz Idiaz] 12@raccisd or; Kinder
(xefresh folder list) ] lelizondo 11 2@rgecisd org Leo Elizondo lelizondo 1 1 2@rgecisd or; Proctor (Commputer Lab)
O Imaldonado112@rgccisd org  Lillian Maldonado Imaldenads 112@rgecisd org Computer Lab
- INBOX O Iperezl12@rgccisd.org LoraL. Perez Iperez112; ceisd. or; Reading Resource Parapro.

DS O malaniz] 12{@rgecisd org Maida Alaniz malaniz] 1 2@rgccisd. org 1st Grade

?‘:sth P O mgarcial 12@raccisd org Maria M Garcia mgarcial 1 2@raccisd org 5th Grade
] mbarreral 12@rgecisd org Marvelia Barrera mbarreral | 2@raecisd org Learning Res. Center
O msalinas 1 12@rgccisd org Melba Salinas mealinas 11 2@rgccisd org 1st Grade Paraprofessional
O mmendozal 12@rgcasd.org  Melnda Mendoza mmendezal 12@rgeoisd org Emnder
O mirejol12@rgecisd.org IMelissa Trejo mirejol12@rgecisd. org Community Aide
O mhincjosal 12@rgreisd org  Merlinda Hinojosa mhinojosal12@rgecisd org 3rd Grade
] mlozane 112@rgecisd org Mirta Lozano mlerane 11 2@raccisd org Acc Reading
O muillarreall 12@raccisd org Monique Villarreal mwillarreal 1 12@ gecisd org Asst. Principal
O aramirez] 12@rgecisd. org Nadia Ramirez nramirez]12@rgccisd. org Emnder
O MLeal Nery Leal NLeal@techdepot.com TECHDEPT
O solivarez] 12@rgccisd. org Sandra Olivarez solivarer] 12@rgerisd org Pre-Kinder
] sflores112@rgecisd org Sixto Flores sflores112@rgecisd org 2nd Grade
O weolis] 12@rgecisd org Veronica Solis weoliz112@raccied org Sth Grade
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Last name: ‘

Additional info: |

Add address

Warning: Importing addresses fom a file will overwrite your existing address book. To prevent this fom happenmg, please EXPORT your current address bool,

and append it to the TMPORT file
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Folder

® Create
® Rename
® Delete Fo

lders

2 RattlerMail 1.4.2 - Microsoft Internet Explorer
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Options - Persona

2 RattlerMail 1.4.2 - Microsoft Internet Explorer,

File Edit Wiew Favorites Tools Help #

°Back - @ B @ @ psaarch *Favnrltas 6 B- é__—% " | D @ il 3

Address @ http:f/mail rgecisd.org)srcmebmail php Vl Go  Llinks
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Name and Address Options
Full Name: ‘Maweha Barrera ‘
Email &ddress: ‘mbarrerm 12(@rgecisd.org ‘
Eeply To: ‘ ‘

Marvelia Barrera

Librarian

Signature. Dr. Mario E. Ramirez Elementary
Rio Grande City CISD

Multiple Identities: Bdit Advanced Identities (discards changes made on this form so far)

Tumnezone Options

Your current timezone: ‘ US/Central V|

Reply Citation Options
Reply Citation Style:
User-Defined Citation Start: l:l
TUser-Defined Citation End: l:l

Signature Options
Use Signature: @ Yes O No
Prefiz Signature with '-- 'Line: O Yes & No
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Options - Message Highlighting

» Based upon given criteria, incoming messages can have different
background colors in the message list. This helps to easily distinguish who
the messages are from, especially for mailing lists.

e Click on Options and then Message Highlighting.

 Click on New , Enter Identifying name and select color.

« Under Matches enter e-mail address to be identify.




Change Password - Secure

* To Change Password, type old password then type new
password and then type it again in the Verify New
Password Box and click Submiit.
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Address Groups

* To add groups to your e-mail, go to Options then
Address Groups.

® Click on Add New Members

» Search or List all for e-mail addresses in your address
book.




Options - Display Preferences

* You can change the way that Rattler Mail looks and
displays information to you, such as the colors, the
language, and other settings.
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Options-Folder Preferences

* These settings change the way your folders are
displayed and manipulated.
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Show Clock o Folders Panel:[DDO HHMM ¥
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Options - Mail Forwarding

* You may forward your incoming mail to other email
addresses by using this option.




Technology

e http://www.emailreplies.com/

* To reset password call 956-716-6996 and speak to Mrs.
E. Alvarez.


http://www.emailreplies.com/�
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